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Introduction

The purpose of graduate study is to provide academic opportunities to extend the
boundaries of knowledge and experience. These opportunities enable qualified
individuals to obtain a comprehensive and thorough understanding of a more specific
body of knowledge. A thesis or research paper constitutes a tangible measure of this
academic achievement.

The candidate for a master’s degree is expected to have a strong general knowledge of
the field and competence in the research and applied skills recognized in that field. The
candidate and the Advisory Committee share with the University the responsibility for
protecting and improving this quality. The value ofany research or scholarly activity is a
direct result of the skill with which it is communicated to fellow specialists and other
educated people. Bemidji State University subscribes to the highest ethical standards in
the conduct of all scholarly endeavors. In this regard, all sources contained in the
investigation shall be given proper credit.

The candidate, as the principal investigator and author, is expected to display initiative in
planning a satisfactory program of investigation, in completing the investigation, and in
writing a thesis or research paper in accordance with the requirements of both the general
graduate guidelines and the department/program style requirements. Theses and research
papers differ primarily in representing different levels of investigation, specialization, and
presentation. Although there are important differences in the level of investigation
represented by the master’s thesis and research paper, both are similar end products of
investigation. Both must conform to certain fundamental rules of literary and scholarly
presentation.

A research project involves the collection, evaluation, and effective presentation of
information pertaining to a clearly defined problem ofa limited scope. The degree
candidate is expected to perform ina manner that demonstrates respect for grammatical
principles and to reflect competent literary style. The mode of scholarly presentation will
vary according to the different fields of knowledge. The research process requires close
contact between the degree candidate and the entire advisory committee.



Thesis, Research Paper, and Graduation Expenses

All thesis and research paper candidates are required to register via arranged course work
for credit at which time the initial investigation commences. The precise number of
thesis/research paper credits required may vary:

e The thesis credit requirement may not exceed six (6) semester hours.
e The research paper may not exceed two (2) semester hours.

The candidate is expected to meet with his/her advisor for the purpose of presenting an
initial topic proposal to the Advisory Committee. This meeting should occur prior to
initiating the investigative process. The candidate should also seek input and approval
fromall committee members on the research topic. Once the topic is approved by the
committee, the student should submit a proposal and Form 3 — Graduate Research
Paper/Thesis Proposal Approval Form to the School of Graduate Studies.

Expenses

The actual expenses incurred in the preparation and duplication of the thesis/research
paper will vary. The following is a list of expenses that may be incurred:

1. Aword processing service fee (optional).

2. Twenty-pound, 25 to 100 percent rag or cotton bond paper (required for the final
thesis copy only).

3. Photocopying of the four draft copies to be provided to the three Oral
Examination Committee members and the Graduate Faculty Representative.

4. Submission of final paper:

a. Thesis: Bindings for the two final copies of the thesis (one twenty-pound
copy and one photocopy for the library and any additional for personal use)
are to be submitted to the School of Graduate Studies once appropriate
signatures have been secured.

b. Research Paper: A single research paper copy (with original signatures of
committee members and Graduate Faculty Representative) for the department
must be submitted to the School of Graduate Studies. Research papers are not
provided to the library.

5. Inaddition, a $10 graduation fee made payable to Bemidji State University must
be attached to the Application for Graduation (Form 4) and submitted to the

School of Graduate Studies.



10.

Eleven Steps to the Completion of the Thesis or Research Paper

Once approval has been given for Admission to Candidacy, the candidate selects
a research topic or problem with the approval of the advisor.

The candidate determines the members of the master’s committee in consultation
with the advisor.

The candidate prepares a proposal on the research topic for presentation to the
committee members. Once all committee members approve the topic, Form3 —
Proposal Approval Form, is signed by committee members and submitted to the
School of Graduate Studies.

The candidate conducts the necessary investigation with the guidance of the
advisor and in conjunction with the committee members. If the investigation will
involve human subjects, approval must be secured PRIOR to implementation of
data collection. Please visit the School of Graduate Studies website for
appropriate approval forms.

The initial draft is provided to the advisor for review. Once the advisor has
reviewed the draft, a copy is provided to all members of the master’s committee.

The candidate will submit Form 4 — Application for Graduation, and be assigned a
Graduate Faculty Representative. Note: Candidates should register for the
thesis/research paper credits with the advisor at this time, during the
semester or summer session in which the oral defense is scheduled.

When the members of the student’s graduate committee have read and provided
feedback to the student, the candidate will secure signatures on Form5, Pre-
Defense Signature, and submit the form to the School of Graduate Studies. Only
after the student has submitted Form 5 will the School of Graduate Studies assign
a Graduate Faculty Representative to the student’s graduate committee.

An electronic AND hard copy of the approved draft is provided to the School of
Graduate Studies at least three weeks prior to the date of the oral examination.
The electronic copy will be reviewed for formatting and the hard copy will be
forwarded to the appointed Graduate Faculty Representative.

The candidate defends the thesis/research paper at the oral examination. The
committee may request modifications or changes to the draft, based on the oral
defense.

All modifications or changes to the thesis/research paper must be completed to the
satisfaction of the advisor and/or committee.



11. Provide the approved manuscript(s) to the advisor and committee for signatures.
Then submit the manuscript(s) to the School of Graduate Studies.

a. The thesis candidate must provide two (2) approved manuscripts for
signatures. One thesis copy must be on twenty-pound, 25 to 100 percent rag or
cotton bond paper. The copies must be two- or three-hole punched and bound
in a black left-sided, heavy-duty report cover with metal fasteners
(occasionally provided by Graduate Studies). The exact title of the thesis and
the full name of the author must appear on the front cover.

b. The research paper candidate must provide one (1) approved manuscript for
signatures. Regular printer paper may be used for the research paper. The
copy must be two- or three-hole punched and bound in a black left-sided,
heavy-duty report cover with metal fasteners (occasionally provided by
Graduate Studies). The exact title of the research paper and the full name of
the author must appear on the front cover.



Page Sequence of a Thesis or Research Paper

Every thesis or research paper submitted to the School of Graduate Studies must conform
in every aspect to the following requirements.

Page
1. Label On frONT COVEN ..c.oiiiieie i 17
2. Blank sheet (fly leaf) - unnumbered
3. Address page — UNNUMDETE ..........couiiiieieieiie e 18
4. Title page - sSMall ROMaN f.....ccveiiiiiiiiiiiicc e 19
5. Author’s Statement/Approval page - (small Roman i) .......cccccoevveiiiniinnne, 20
6. Abstract page - (Small ROMaN i) .....cooeiiiiiiiiiiiiceeeee e 21
7. Acknowledgments page (optional) - (small Roman iv).......cccccceevvveivcnnenee. 22
8. Table of Contents page(s) - (small Roman number)........ 24(APA), 40(MLA)
9. Listof Tables page - (small Roman number) ..., 28
10. List of Figures page — (small Roman number) ..o, 29

11. Text pages — numbered (Arabic)

12. References/Works Cited page(s) - numbered (Arabic).... 37(APA), 42(MLA)
13. Appendix page(s)* - numbered (Arabic)

14. Blank sheet (fly leaf) - unnumbered

Note: All page numbers, both Roman and Arabic, are to be placed in the upper right hand
corner of the page. The placement is 1/2" from the top of the page and aligned with the
right margin (within the header).

APA: Page numbers are required. A page header (the first two or three words
of the title) is optional; see p. 288 of the APA Manual 5" Edition or p. 230
of the APA Manual 6% Edition.**

MLA: Last name of student and page number are required.

* The appendix page(s) follow the References or Works Cited pages only if there are no
references cited in any appendix. Ifany appendix contains reference citations, the
References or Works Cited pages follow the appendix pages.

** Students who began their program before Fall 2010 may use APA 5" or 6™ Edition.
All students who start their program in Fall 2010 or beyond are required to use APA 6"
Edition unless otherwise agreed upon by advisor and committee. Should another style
manual be used, it is the student’s responsibility to provide to the School of Graduate
Studies a detailed accounting of the requirements.




General Guidelines

The mechanics: The department/program style manual (APA, MLA, etc.) takes
precedence over all general guidelines with the exception of the front matter pages.
Students should use the Handbook for the Preparation of the Thesis or Research Paper in
order to correctly format their papers/projects and should supplement with other
specialized handbooks that may come from their departments or are available online.

Abstract — The final required element in the preliminary or front matter (before the
Table of Contents) is the abstract. The abstract should begin with a clear
statement of the problem. The purpose of the abstract is to concisely summarize
the methods of investigation, significant content, system of analysis, findings, and
conclusions of the study. The abstract statement should not exceed 300 words.
The abstract is to be written in the same person and tense as the text (See p. 21).

Acknowledgme nts — Acknowledgments recognize the person(s) to whom the student is
indebted for encouragement, guidance and special assistance. This page should
also include recognition of any grants or financial assistance that was received to
support the research. This page is optional. No part of the thesis/research paper
that is essential to the understanding of the main body of the text should appear on
the acknowledgment page (See p. 22).

Appendix Pages — An appendix contains material that is useful for detailed review, but is
not essential to the study. For example, an appendix is an appropriate section in
which to place certain kinds of tabular and graphic material. This material is
available as supporting data even though it may not be specifically utilized in the
text. However, such material must be referenced in the text.

Each appendix is identified by a letter in a sequence independent of the
numbering system used for the chapters. However, the pages of an appendix are
numbered in sequence with those in the text. Each appendix must beginona
new page and must be listed in the Table of Contents.

The appendix pages follow the References or Works Cited pages only if there
are no references cited in any appendix. Consult the required
department/program style manual (APA, MLA, etc.) for correct formatting.

Author’s Statement/Approval Form— There are two primary purposes for this page.
The first indicates approval of the thesis/research paper by the student’s advisor
and the Dean, School of Graduate Studies. The second protects the research from
unauthorized use. The author approval form should follow the title page (See
p.20).



Binding — The approved manuscript(s) with original signatures from the committee
members and graduate faculty representative must be submitted to the School of
Graduate Studies appropriately formatted and prepared for binding. For those who
wish to bind their own work, a black heavy-duty report cover with metal
fasteners (two- or three-hole punch) is required, and the exact title of the thesis or
research paper and the full name of the author must appear on the front cover (see
p. 17). See page 8 for correct page sequencing. The following indicates the
correct number of copies that must be submitted to the School of Graduate
Studies:

e Thesis: Two (2) approved manuscripts of the thesis must be submitted (See
“Paper” for further details).

e Research Paper: One (1) approved copy of the research paper must be
submitted.

*Those who wish to have additional copies bound must provide their own
binders.

Capitalization — All research projects must conform to standard rules in the use of
capitalization (See the appropriate department/program style manual, i.e., APA,
MLA, etc.).

Centering/Vertical Centering — When centering is required, all word-processed copies
should be centered within the margins of the paper, not within the 8 1/2 x 11 inch
page. The margin spacing will vary depending on the type style selected. This
also applies to charts, tables, graphs, figures, or other reproductions. Some front
matter pages require vertical centering. Note: There are templates available on
the School of Graduate Studies website, which already have the vertical
centering done for you.

To center text vertically on a page yourself:

Microsoft® Word 2003 Microsoft® Word 2007

1. Insert page breaks before and 1. Insert page breaks before and
after the text to be vertically after the text to be vertically
centered centered

2. Highlight the text to be 2. Highlight the text to be
vertically centered vertically centered.

3. Inthe File menu, select Page 3. Onthe Page Layout tab,
Setup select the lower right corner

4. Go to the Layout tab of Page Setup

5. Under Page, Vertical 4. Go to the Layout tab
alignment, select Center 5. Under Page, Vertical

6. Be sure that the “Apply to:” alignment, select Center
box shows “this section” 6. Be sure that the “Apply to:”

7. Click onOK box shows “this section”

7. Click onOK

10



Chapter Headings — APA — see APA Manual 5" Edition, pages 113-115, APA Manual
6™ Edition, pages 62-63, and pages 30-36 in this handbook; M LA — see page 41
of this handbook.

Copies Required — Four draft copies are required for the examination committee. One
hard copy AND electronic copy is to be provided to the School of Graduate
Studies at least three weeks prior to the oral examination. The hard copy will
be provided to the Graduate Faculty Representative and the electronic copy will
be reviewed for formatting

Copyright — Typically, theses are not copyrighted. 1fthe student’s thesis will be
published, it should be copyrighted. A copyright notice should be included in the
title page (see p. 19).

Duplication — Two methods have been approved for the reproduction of a thesis/research
paper. The first acceptable method consists of a photocopy of the original. The
second method includes two copies produced on a word processor. All copies
must be neat and clean. Inferior photocopies or those with dirty, smudged, or
streaked backgrounds will not be approved. Pages of illustrations or graphs that
cannot be corrected on a word processor may be printed by an approved
alternative process. It is recommended that candidates consult with the School of
Graduate Studies for the purpose of reviewing alternative processes.

Erasures and Strikeovers — Erasures and strikeovers are not permitted on the final
copies. Correction fluid may not be used in the removal of errors.

Figures — All figure captions should conform to the guidelines in the approved style
manual (APA, MLA, etc.). If figures are involved, a List of Figures page(s)
should immediately follow the Table of Contents and any List of Tables page(s)
in the front matter.

Fly Leaf — The fly leaf sheets are not numbered. The purpose of these sheets is to protect
the title page and back matter. The fly leaf blank sheets should precede the title
page and follow the last page in the manuscript (see p. 8).

Front Matter — This section consists ofall preliminary information (title page, statement
by author, abstract, etc.) prior to the presentation of the text (see Appendix A).

List of Figures - The entries should be identical to the figure captions in the text and
conform to the guidelines in the approved style manual. The List of Figures
page(s) should immediately follow the Table of Contents and any List of Tables
page(s) in the front matter (See p. 29).

List of Tables — The entries should be identical to the table titles in the text and conform
to the guidelines in the approved style manual (APA, MLA, etc.). If tables are

11



involved, the List of Tables page(s) should immediately follow the Table of
Contents page(s) in the front matter (See p. 28).

Margins — The text margin guidelines are contained in the handbook. Additional margin
guidelines may be included in the departmental/program style manual (APA,
MLA, etc.). Generally, the left margin must be one and one-half inches (1%2”) in
width with the other margins (top, right, bottom) one inch (1) in width. All
typing, reproductions, appendices, and footnotes, must be within these margins.
All page numbers are to be ¥2 " from top of page, aligned with the right margin.
The text of the paper must be double spaced, with the exception of lengthy
quotations (APA/MLA) and the references (APA). Consult with the required
departmental/program style manual for additional information.

Page Numbering Sequence — All front matter pages (title page, abstract, etc.) must be
numbered with Roman numerals. The title page is counted as the first page, and is
numbered “i”. All text pages must carry Arabic numbers beginning with “1”.
Every page must be accounted for in the numbering system with the exception of
the fly leaf sheets and the address page. *M LA: Last name must appear on all
numbered pages of the research/thesis paper.

Paper — The paper to be used for research papers and final library approved thesis
manuscript copies must be 8% x 11 inches in dimension.

e Thesis papers must be printed on 20-pound bond, having 25 to 100 percent
rag or cotton content (the second copy may be a photocopy). Erase,
correctable, or other erasable bond paper is not acceptable. Continuous feed
paper cannot be used. The entire paper must be of the same quality, brand, and
degree of whiteness. Bond paper is water marked. The paper should be
arranged so the watermark is both right side and top-side up (see Word
Processing).

e Research papers may be printed on 20-pound, non-cotton printer paper.

Photocopying — Very specific rules and guidelines govern the circumstances under
which photocopying may occur. Contact the University Library when using
copyrighted works in the text. Guidelines are also available in the Copyright
Office Circular R21, “Reproduction of Copyrighted Works by Educators and
Librarians.” This publication is available through the United States Copyright
Office.

Preface — (See “Acknowledgments™)

Questionnaires, Surveys, and Related Materials — The purpose of illustrative material
is to present information or data in a format more clearly than it can be stated in
words alone (see “Figures’). All illustrative materials must be presented on an
8% x 11 inch page and within the acceptable margins. The candidate is
encouraged to consult with the department/program style manual (APA, MLA,
etc.) because of the variability in the nature of illustrations. *Students who plan

12



to use human subjects in their research must seek approval fromthe Human
Subjects Committee prior to collecting the data. Appropriate approval forms
may be accessed on the School of Graduate Studies website.

References or Works Cited — All studies must contain source information. In most
instances, the source information is called “References” (APA) or “Works Cited”
(MLA) and consists only of sources cited in the text or appendices. The
References or Works Cited pages should follow the text, and the pages are
numbered in sequence with the text. If any appendix contains reference
citations, the References or Works Cited pages follow the appendix pages.
Consult the appropriate department/program style manual for the correct form.

Special Mountings with Adhesives — A large photograph or a full page of photographic
illustrations should be directly on photographic paper 8% x 11 inches. However, if
photographs or other materials requiring special mountings are included, the
paper for mounts should be *“Alexis™ Lietz Sequbio (#1005), or pliable Bristol
Board insheets 8%2 x 11 inches. The adhesive may be Kodak D ry Mounting
Tissue or a polyvinyl plastic adhesive, such as Duratite, Wilhold, or Borden’s.
*Do not use rubber cement under any circumstances. Double-faced scotch
tape may be used if special care is exercised so as not to allow the tape to show.

Style Manuals — Each department/program has a required style manual to be used for the
thesis/research paper. The most recent edition is to be used in all research.

APA — Students who begin their program before Fall 2010, may use the
Publication manual of the American Psychologlcal Association, 5" Ed. OR 6'"
Ed., Washington, D.C.: American Psychological Association; Students who begin
their program by or after Fall 2010, must use Publication manual of the American
Psychological Association, 6™ Ed., Washington, D.C.: American Psychological
Association.

MLA — Modern Language Association of America. MLA Style Manual and Guide
to Scholarly Publishing, 3" Ed. New York, NY: 2008.

e Biology — After consent with their advisors, students will follow the format of
the Publication Manual of the American Psychological Association or an
appropriate journal in their area of expertise. *Students must provide a
complete description and examples for the journal format they wish to
use to the School of Graduate Studies when they submit their final draft
for formatting review.

e Education - Publication Manual of the American Psychological Association
(see “APA” section above for specific edition).

13



English — The thesis or research paper is written using either the APA (see
“APA” section above for specific edition) or MLA style manual as determined
by the major advisor.

Environmental Studies — After consent with their advisors, students will
follow the format of the Publication Manual of the American Psychological
Association or an appropriate journal in their area of expertise. *Students
must provide a complete description and examples for the journal format
they wish to use to the School of Graduate Studies when they submit their
final draft for formatting review.

Industrial Technology — Publication Manual of the American Psychological
Association (see “APA” section above for specific edition).

Mathematics — Publication Manual of the American Psychological
Association (see “APA” section above for specific edition).

Science — The body of the thesis/research paper must conform to the
recommendations of the style manual specified in the catalog by the area of
science in which the thesis/research paper is written.

Sport Studies (Physical Education) — Publication Manual of the American
Psychological Association (see “APA” section above for specific edition).

Table of Contents — The Table of Contents is a complete listing with page numbers of
all sections of the thesis or research paper. Since most theses and research papers
do not have an index, it is desirable to have the Table of Contents be a detailed
listing of all major subdivisions of the text rather thana simple list of chapter
headings.

Entries — It is essential that wording in the Table of Contents listing be
identical to that of the heading in the text in every case. A sample Table of
Contents is provided on pp. 24-27 (APA) and 40 (MLA).

Page Numbers — Align the page numbers flush right with dot leaders.

o InMicrosoft® Word 2003, go to the Format menu and select Tabs. Select
or type in the tab stop position and select Alignment Right and Leader 2
cevv... . Click Set and Ok.

o InMicrosoft® Word 2007, from the Home menu, go to the Paragraph
section and select the small arrow in the lower right corner. Select Tabs in
the lower left corner of the Paragraph window. Select or type in the tab
stop position and select Alignment Right and Leader 2 ........ Click Set
and OKk.

Tables — All Tables and table titles should conform to the guidelines in the approved
style manual (APA, MLA, etc.). Iftables are involved, the List of Tables page(s)

14



should immediately follow the Table of Contents page(s) in the front matter (See
p. 28). The table titles should be identical to the entries in the List of Tables.

Word Processing — The final copy must be produced on a letter quality printer. Students
are permitted to use Printing Services (Memorial Hall) or access the BSU Library
to print their final drafts.

Text— The text is the main body of the thesis/research paper. Text is
generally double-spaced, except where otherwise indicated (e.g. block quotes,
table titles and headings, figure captions, notes in tables and figures, and
footnotes). See the appropriate department/program style manual (AP A,
MLA, etc.) for more information on single-spacing within a text. The text is
divided into sections called headings (i.e. chapters, subdivisions). There must
be an exact correspondence between the headings in the text and the
entries in the Table of Contents.

Title Page — The title page contains the exact title of the thesis or research
paper, the full name of the author, the degree to be awarded, the institution
granting the degree, and the year the degree will be granted (see p.19). The
title page is to be followed by the Author’s Statement/Approval page (see p.
20). There is no difference between the title page of a thesis paper or research
paper. If the title is more than one line, an inverted pyramid must be used. No
title should be more than three lines.

Type Styles and Symbols — One size of type (12 pt. font preferably) must be
used throughout the paper (with committee approval, a creative thesis may
have exceptions). Hand-drawn symbols should be in India ink or other high-
contrast black ink. In fields such as Environmental Studies, special
circumstances may require the use of a color ona map or diagram. Color may
be used only when it is standard practice in the specific field.

15



Appendix A

Sample Front Matter Pages
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Label for Front Cover

This is a sample of the label that goes on the front of the binder(s) for the thesis or
research paper.

Do not include this
In your paper.

THE TITLE IS IN ALL CAPS, CENTERED, AND
SINGLE SPACED FOR THE THESIS OR
RESEARCH PAPER
(1 blank line)
by
(1 blank line)

John H. Doe

Label size is approximately 2" x 4”. Text must be centered vertically and
horizontally. The label must be affixed to the front cover of the bound thesis
copies (2) or research paper (1).

17



(no page number)

Address Page

Establish a left margin of 1.5 inches on ALL pages for binding purposes and be certain
to maintain a margin of at least 1 inch on the top, right, and bottom of the page.
From the 1-inch top margin, text begins on line 33, typed in upper and lower case,
single-spaced, and centered. Do not place a page number on this page.

School of Graduate Studies
Bemidji State University
1500 Birchmont Dr NE, #27
Bemidji, MN 56601-2699
218-755-2027

18



Title Page

Margins: 1.5 “ left; 1” top, right, and bottom. Center the text vertically on this page
(see Word Processing, Text, p. 13). Use Roman numeral page numbers on Front
Matter pages; place the numbers %2 inch from top edge, flush with right margin.

A DISCRIMINATIVE STUDY OF METHODS FOR
THE QUALITATIVE DETERMINATION OF FLORINE
(1 blank line)
by
(1 blank line)

William Robert Howard

(7 blank lines)

(line is 20 spaces long)

(7 blank lines)

A Thesis Submitted to the Faculty of the
DEPARTMENT OF BIOLOGY
(1 blank line)
In Partial Fulfillment of the Requirements
For the Degree of
(2 blank lines)

MASTER OF SCIENCE IN BIOLOGY
(2 blank lines)

BEMIDJI STATE UNIVERSITY
Bemidji, Minnesota, USA
(1 blank line)
June 2010
(1 blank line)
Copyright 2010 by William Robert Howard
(optional copyright notice)

19



Author’s Statement/Approval Page

The Title and Statement by the Author must begin 3 inches from the top edge of the
paper or 11 blank lines from the 1-inch top margin. Candidates completing a
research paper should substitute “research paper” for “thesis” where it appears on this

page. The first paragraph contained below is not required for the research paper.
Roman numeral page number must be ¥ inch from top edge and flush with right

margin.

STATEMENT BY THE AUTHOR

(1 blank line)
This thesis has been submitted in partial fulfillment of requirements for an advanced
degree at Bemidji State University and is deposited in the University Library to be made
available to borrowers under the rules of the library. (First paragraphis to be included
in thesis papers only — delete for research paper.)

(1 blank line)
Brief quotations from this thesis are allowable without special permission, provided
accurate acknowledgement of the source is indicated. Requests for permission to use
extended quotations or to reproduce the manuscript in whole or in part may be granted by
(insert name of department/program) or the Dean, School of Graduate Studies when
the proposed purpose is in the interest of scholarship. Inall other instances, however,
permission must be obtained from the author.

(1 blank line)
Signed:

(Student: Please sign final paper before you submit it to your advisor.)
(3 blank lines)

(line is 50 spaces, centered)
(2 blank lines)
APPROVAL BY THESIS ADVISOR

(2 blank lines)
THIS THESIS HAS BEEN APPROVED ON THE DATE SHOWN BELOW:

(3 blank lines)

(Name of Professor), Date
Committee Chair
Professor of (Department Name)

Dean, School of Graduate Studies Date
*Do not list the name of the Dean
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Abstract Page

Margins: 1.5 “ left, 1” top, right, and bottom. Center the text vertically on this page
(see Word Processing, Text, p. 13). Title and name must match those on the title
page. Title and name must match those on the title page. Title must be in all caps and
centered; author’s name is typed in upper- and lower-case lettering and centered. The
abstract statement should not exceed 300 words. Roman numeral page numbers
must be ¥z inch from top edge, flush with right margin.

LEARNING ABOUT THE VALUE OF
GLOBAL COOPERATION
(1 blank line)
John Q. Public
(2 blank lines)

As a corollary to Robert Angell’s measures of world order, this study examines nation-
state differences in support for world order as a function of learning through involvement
in the United Nations. Differences in national support for world order are analyzed in
terms of “role-taking” and “cue-taking” in the United Nations. Seven types ofroles,
based on the degree to which nation-states approximated support for the norms of the
organization, are identified. Correlational analysis indicates that these roles function as
good predictors to variance among nations in their support for world order. Alternatively,
nations which could not be classified as taking on a definitive role were hypothesized to
be “taking cures” about the value of global cooperation from their regional counter parts.
This predicted outcome was also supported. Finally, analysis of “deviant” cases
indicated that for some nations, both role-taking and cue-taking may be equally salient
for supporting world order.

(1 blank line)
Approved by:

(2 blank lines)

Committee Chair Date

Committee Member

Committee Member

Graduate Faculty Representative

(2 blank lines between Committee Chair and signature lines throughout)
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Acknowledgments Page

This page is optional. Margins: 1.5” left, 1” top, right, and bottom. Roman numeral
page number must be ¥z inch from top edge and flush with right margin. Text

should be centered and begin 3” from top of paper or 11 blank lines from the
1-inch top margin.
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*For Sample Table of Contents formatting, see the appropriate
style example appendix.
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Appendix B

APA Style Examples

Table of Contents Sample 1: APA 5" Ed.

Table of Contents Sample 2: APA 6" Ed.
Sample List of Tables

Sample List of Figures

Sample Chapter Headings (APA 5" and 6" Ed.)
Sample References
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Sample Tables of Contents (TOC) (APA 5" Ed. and 6" Ed. Styles)

TOC Sample 1: APA 5™ Ed. The following example is consistent with a three
levels of heading paper in the APA 5" Edition format. For a two, four, or five levels of
heading paper, please refer to the APA Manual, 5" Ed. (pp. 113-115), and pages 30-33
of this handbook. Headings must be presented in a format identical to the format
used in text.

Roman numeral page number must be ¥z inch from top edge and flush with right
margin. Margins are 1.5” left, 1” top, right, and bottom. Center all text vertically
within the margins unless the TOC extends beyond one page.

(small Roman numeral)

TABLE OF CONTENTS
(1 blank line)
LIST OF TABLES ... .ottt vii
(1 blank line)
LIST OF FIGURES ..ottt sttt viii
(1 blank line)
Chapter Page
1. Introduction
Statement of the Problem ... 1
Background of the Problem ... 2
Limitations and Assumptions of StUAY ..........ccceveriiiiiinnie e 3
DefiNItioNS OF TEIMS.....iiieiiee et 4
(1 blank line)
2. Review of Literature (Level 1)
General Components of Service Learning (Level 3)......ccovininiiinicicnn 7
Examination of Current School-Community Relationship (Level 3) .............. 10
Methods of examinations (LeVel 4) ........cccooveiieeiiiiiiciiece e 10
Results of examinations (LeVel 4)........ccccoveiiiiiiiinieeeeee, 12
Matching Service Learning Outcomes to School and Community
Expectations (Level 3, heading too long forone line) ..........c........... 17
Direct benefits for those being served (Level 4) ..o 22
Problems encountered within established programs (Level 4)........... 25
Working together for success (Level 4)........ccccovevveieiievncie e 27
(1 blank line)
3. Results
Demographics 0f RESPONAENTS..........ccceiieiiieieiiese e 31
First subheading title ............coooiiiiiiiii e 31
Second subheading title ...........ccoeieiiiiiii e 31
Question 1, Important Issues Facing DiStriCtS .........cccevvvieiiiieiieie e 32
Title Of the FIrSt ISSUE......oieeiiie e 32
Title Of the SECONT ISSUE .....c.vvvvveiiieiieeie e 32
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(small Roman numeral)

Question 2, Teaching Values in Public SChools ...........ccccocevviviiiciiciicee 32
Question 3, Rating the School-Community Relationship..........ccccccovveiiiienens 33
Question 4, Making the Relationship Stronger ...........ccooeveveieneniienisene 33
4. Discussion
Interpretation of SUrVEY RESUIS...........coeiiiiiiii 34
Implications Service Learning Could Have on This District ............cccccccve.ee. 37
Suggestions for Further ReSEarch .........ccccccevviiiii i 39
(1 blank line)
RETBIEIICES ...t bbbttt b e bbbt 40
(1 blank line)
Appendix A. SUrvey QUESTIONNAINE ........coiiiiiieieieie ettt 41
(1 blank line)
APPENdiX B. SUNVEY RESUILS .....cveeiieie ettt 43

Two-page TOC - If the Table of Contents is too long for one page, insert a break
between sections and continue on the next page. Beqin the continuation at the 1-inch

top margin.

Page Numbers — Align the page numbers flush right with dot leaders.

e In Microsoft® Word 2003, go to the Format menu and select Tabs. Select or type in
the tab stop position and select Alignment Right and Leader 2 ....... . Click Set and
Ok.

e In Microsoft® Word 2007, from the Home menu, go to the Paragraph section and
select the small arrowin the lower right corner. Select Tabs in the lower left corner
of the Paragraph window. Select or type in the tab stop position and select Alignment
Right and Leader 2 ....... . Click Set and Ok.

Please note that the page numbers are not italicized.

Very Long Heading — Be sure no heading extends into the page listing area. Continue a
long heading indented on the next line. List the page number opposite the last line of the
heading.
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TOC Sample 2: APA 6" Ed. The following example is consistent with a five
levels of heading paper in the APA 6" Edition format. For a two, three, or four levels
of heading paper, please refer to the APA Manual, 6" Ed. (pp. 62-63), and pages 33-36

of this handbook. Headings must be presented in a format identical to the format
used in text.

Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5” left, 1” top, right, and bottom. Center all text vertically
within the margins unless the TOC extends beyond one page.

(small Roman numeral)

TABLE OF CONTENTS
(1 blank line)
LIST OF TABLES ... .ottt ettt ae e nreans vii
(1 blank line)
LIST OF FIGURES ..ottt sttt viii
(1 blank line)
Chapter Page
1. Introduction
Statement of the Problem.........cooiiii 1
Background of the Problem ... 2
Limitations and Assumptions of StUdy ..........ccccceeviiiieiiiie e 3
DefinNitions OF TeIIMIS......ciiiiiie e 4
(1 blank line)
2. Review of Literature (Level 1)
General Components of Service Learning (Level 2)........cccoooevvviiieiieciee, 7
Examination of Current School-Community Relationship (Level 2)........ 10
Methods of examinations (LeVel 3)........cccovviiieiiieii e, 10
Method 1 (LeVel 4) .....ooovveiieieece e 10
Participant selection (Level 5) ... 10
Assessments and measures (Level 5) .....cccooevveveieenee. 11
Method 2 (LEVEL 4) ..cveeeeceeceeececeee e 11
Participant selection (Level 5)........ccccoovviiiiiinnnnnnne 11
Assessments and measures (Level 5) ... 12
Method 3 (LEVEL 4) ..cveeeeeeceeceee e 12
Participant selection (Level 5).......cccooeiiiiinnnennnne. 12
Assessments and measures (Level 5) ... 13
Results of examinations (Level 3).......ccoovvviieiieiice e 14
Matching Service Learning Outcomes to School and Community
Expectations (Level 2, heading too long for one ling) ............cc.c...... 17
Direct benefits for those being served (Level 3).......cccccevveiviiennne 22
Proble ms encountered within established programs (Level 3)......25
Working together for success (LeVel 3).....coevieienineniiiniceee 27
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(small Roman numeral)

3. Results
Demographics of RESPONUENES........cccooiiiieiiiiesiee e 31
First subheading title ..o 31
Second subheading title ...........ccccoveviiieieciice e 31
Question 1, Important Issues Facing DiStricts .........cccoceveiieeiiciiie e, 32
Title OF the fIrSTISSUR.....cuiiiei e 32
Title of the SECONA ISSUE .....ccuvviiiiiiiiicce s 32
Question 2, Teaching Values in Public SChools............ccccoeviviiiiiiiiciieee. 32
Question 3, Rating the School-Community Relationship..............cc.ccco.. 33
Question 4, Making the Relationship Stronger.......cccccocceviveviviieiieneciennnn 33
4. Discussion
Inte rpretation of SUNVEY RESUILS .........cooiiiiiiiiicce e 34
Implications Service Learning Could Have on This District .................... 37
Suggestions for Further Research ... 39
(1 blank line)
R T IEINCES .. ettt bbbttt e e 40
(1 blank line)
Appendix A. SUNVEY QUESTIONNAITE .........cviiiiiieie e 41
(1 blank line)
ApPPeNdiX B. SUNVEY RESUILS .......ccoeiiieiie ettt 43

Two-page TOC - If the Table of Contents is too long for one page, insert a break
between sections and continue on the next page. Beqin the continuation at the 1-inch
top margin.

Page Numbers — Align the page numbers flush right with dot leaders.

e In Microsoft® Word 2003, go to the Format menu and select Tabs. Select or type in
the tab stop position and select Alignment Right and Leader 2 ....... . Click Set and
Ok.

e In Microsoft® Word 2007, from the Home menu, go to the Paragraph section and
select the small arrowin the lower right corner. Select Tabs in the lower left corner
of the Paragraph window. Select or type in the tab stop position and select Alignment
Right and Leader 2 ....... . Click Set and OKk.

Please note that the page numbers are not italicized.

Very Long Heading — Be sure no heading extends into the page listing area. Continue a
long heading indented on the next line. List the page number opposite the last line of the
heading.
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Sample List of Tables
Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5 left, 1" top, right, and bottom. Begin the text at the 1-inch
top margin.

(small Roman numeral)

LIST OF TABLES
(1 blank line)
Table Page
1. Title Of the First TABIE .....cveoivviiieice e 2
(1 blank line)
2. Title Of the NEXt TAbDIE.......ccveiieree e 5

Page Numbers — Align the page numbers flush right with dot leaders.

e In Microsoft® Word 2003, go to the Format menu and select Tabs. Select or type in
the tab stop position and select Alignment Right and Leader 2 ....... . Click Set and
Ok.

e In Microsoft® Word 2007, from the Home menu, go to the Paragraph section and
select the small arrowin the lower right corner. Select Tabs in the lower left corner
of the Paragraph window. Select or type in the tab stop position and select Alignment
Right and Leader 2 ....... . Click Set and OKk.

Please note that the page numbers are not italicized.
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Sample List of Figures
Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5 left, 1" top, right, and bottom. Begin the text at the 1-inch
top margin.

(small Roman numeral)

LIST OF FIGURES

(1 blank line)
Figure Page
1. Caption for the first figure, serving as an explanation of the figure
and @s a fIQUIE tILle. .......oovreiee e 7
(1 blank line)
2. Caption for the Second fIQUIE. .......c.ecvi e 10

Captions -- Be sure no caption extends into the page listing area. Continue a long
caption on the next line. If a caption is lengthy, the entry in the List of Figures may be
shortened to the first common point of punctuation (comma, colon, semi-colon, or
period), and all entries must be consistent with the format chosen. List the page number
opposite the last line of the caption.

Page Numbers — Align the page numbers flush right with dot leaders.

e In Microsoft® Word 2003, go to the Format menu and select Tabs. Select or type in
the tab stop position and select Alignment Right and Leader 2 ....... . Click Set and
Ok.

e In Microsoft® Word 2007, from the Home menu, go to the Paragraph section and
select the small arrowin the lower right corner. Select Tabs in the lower left corner
of the Paragraph window. Select or type in the tab stop position and select Alignment
Right and Leader 2 ....... . Click Set and Ok.

Please note that the page numbers are not italicized.
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Sample Chapter Headings (APA 5" Ed. and 6" Ed. Styles)

Arabic page number must be ¥z inch from top edge and flush with right margin.
Margins are 1.5” left, 1” top, right, and bottom.

APA Style: Please refer to the APA Manual, 5™ Edition (pp. 113-115) or APA Manual,
6™ Edition* (pp. 62-63), to determine how your headings should appear. Find the
section of your paper that breaks into the finest level of subordinate categories. Then
use the guidelines that follow to determine the level, position, and arrangement of
headings.

* Students who began their program before Fall 2010 may use APA 5" or 6™ Edition. All
students who start their program in Fall 2010 or beyond are required to use APA 6"
Edition.

APA Manual 5™ Edition (for those who started their program before Fall 2010)

Onelevel. Only use Level 1. Start each chapter on a new page.

Example:
(Arabic page number)

Centered Uppercase and Lowercase Heading
The indented, double-spaced text starts here. All headings (Level 1) are centered

and uppercase and lowercase.

Two Levels. Use Levels 1 and 3. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 1: Title of the Chapter
The indented, double-spaced text starts here. The chapter headings (Level 1) are

centered and uppercase and lowercase.
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Sub-heading Title
The indented, double-spaced text starts here. The sub-headings (Level 3) are flush

left, italicized, and uppercase and lowercase.

Three Levels. Use Levels 1, 3, and 4. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 2: Title of the Chapter

The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered and uppercase and lowercase.
Sub-heading Title

The indented, double-spaced text starts here. The sub-headings (Level 3) are flush
left, italicized, and uppercase and lowercase.

Sub-heading of the sub-heading. These sub-headings (Level 4) are italicized and
indented five spaces. Only the first word in the subheading is capitalized, and the sub-
heading ends in a period. Double-spaced text immediately follows the sub-heading on the

same line.

Four Levels. Use Levels 1, 2, 3, and 4. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 3: Title of the Chapter
The indented, double-spaced text starts here. The chapter headings (Level 1) are

centered and uppercase and lowercase.

31



Sub-heading of the Chapter

The indented, double-spaced text starts here. The sub-headings of the chapter
(Level 2) are centered, italicized, and uppercase and lowercase.
Sub-heading Title

The indented, double-spaced text starts here. These sub-headings (Level 3) are
flush left, italicized, and uppercase and lowercase.

Sub-heading of the sub-heading. These sub-headings (Level 4) are italicized and
indented five spaces. Only the first word is capitalized, and the sub-heading ends in a

period. Double-spaced text immediately follows the sub-heading on the same line.

Five Levels. Use Levels 1-5. Start each chapter on a new page.

Example:
(Arabic page number)
CHAPTER 2: REVIEW OF THE LITERATURE

The indented, double-spaced text starts here. The chapter headings (Level 5) are

centered and uppercase.
General Components of Service Learning

The indented, double-spaced text for this section of Chapter 2 starts here. The

heading (Level 1) is centered and uppercase and lowercase. ...
Methods of Examinations

The indented, double-spaced text for this sub-section of Examination of Current

School-Community Relationship (in Chapter 2) starts here. The heading (Level 2) is

centered, italicized, and uppercase and lowercase. ...
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Survey Document

The indented, double-spaced text for this sub-section of Methods starts here. The
heading (Level 3) is flush left, italicized, and uppercase and lowercase. ...

Response Results. These sub-headings (Level 4) are italicized and indented five
spaces. Only the first word is capitalized, and the sub-heading ends in a period. Double-

spaced text immediately follows the sub-heading on the same line.

APA Manual 6™ Edition (for those who started their program in Fall 2010 and
beyond)

One level. Only use Level 1. Start each chapter on a new page.

Example:
(Arabic page number)

Centered, Boldface, Uppercase and Lowe rcase Heading
The indented, double-spaced text starts here. All headings (Level 1) are centered,

boldface, and uppercase and lowercase.

Two Levels. Use Levels 1 and 2. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 1: Title of the Chapter
The indented, double-spaced text starts here. The chapter headings (Level 1) are

centered, boldface, uppercase and lowercase.
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Sub-heading Title
The indented, double-spaced text starts here. The sub-headings (Level 2) are flush

left, boldface, uppercase and lowercase.

Three Levels. Use Levels 1, 2, and 3. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 2: Title of the Chapter

The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered, boldface, uppercase and lowercase.
Sub-heading Title

The indented, double-spaced text starts here. The sub-headings (Level 2) are flush
left, boldface, uppercase and lowercase.

Sub-heading of the sub-heading. These sub-headings (Level 3) are indented,
boldface, lowercase paragraph ending with a period. Only the first word in the
subheading is capitalized. Double-spaced text immediately follows the sub-heading on

the same line.

Four Levels. Use Levels 1, 2, 3, and 4. Start each chapter on a new page.

Example:
(Arabic page number)

Chapter 3: Title of the Chapter
The indented, double-spaced text starts here. The chapter headings (Level 1) are

centered, boldface, uppercase and lowercase.
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Sub-heading of the Chapter

The indented, double-spaced text starts here. The sub-headings of the chapter
(Level 2) are flush left, boldface, uppercase and lowercase.

Sub-heading title. The indented, double-spaced text starts here. These sub-
headings (Level 3) are indented, boldface, lowercase paragraph ending with a period.
Only the first word in the subheading is capitalized. Double-spaced text immediately
follows the sub-heading on the same line.

Sub-heading of the sub-heading. The indented, double-spaced text starts here.
These sub-headings (Level 4) are indented, boldface, italicized lowercase paragraph
ending with a period. Only the first word is capitalized. Double-spaced text immediately

follows the sub-heading on the same line.

Five Levels. Use Levels 1-5. Start each chapter on a new page.

Example:
(Arabic page number)
Chapter 2: Review of the Literature

The indented, double-spaced text starts here. The chapter headings (Level 1) are
centered, boldface, uppercase and lowercase.
General Components of Service Learning

The indented, double-spaced text starts here. The sub-headings of the chapter
(Level 2) are flush left, boldface, uppercase and lowercase.

Methods of examinations. The indented, double-spaced text starts here. These

sub-headings (Level 3) are indented, boldface, lowercase paragraph ending with a period.
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Only the first word in the subheading is capitalized. Double-spaced text immediately
follows the sub-heading on the same line.

Survey document. The indented, double-spaced text starts here. These sub-
headings (Level 4) are indented, boldface, italicized lowercase paragraph ending with a
period. Only the first word is capitalized. Double-spaced text immediately follows the
sub-heading on the same line.

Response results. These sub-headings (Level 5) are indented, italicized lowercase
paragraph ending with a period. Only the first word is capitalized. Double-spaced text

immediately follows the sub-heading on the same line.
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Sample References

Arabic page number must be ¥z inch from top edge and flush with right margin.
Margins are 1.5” left, 1” top, right, and bottom.

Follow instructions in your thesis/research paper manual:

Publication Manual of the American Psychological Association 5™ Edition* — see Chapter
4, Reference List (pp. 215-281, 299)

Publication Manual of the American Psychological Association 6™ Edition** — see
Chapter 7, Reference examples (pp. 193-224)

o References — only the sources that are cited in your thesis or research paper

e Bibliography — sources for background or for further reading; you may include
descriptive notes with the source listings

e Annotated Bibliography — contains additional information about the reference
source; formatting will require additional guidance from your committee

* Only students who began their program before Fall 2010 may use APA 5" or 6" Edition
**hAII students who start their program in Fall 2010 or beyond are required to use APA
6" Edition

The following formats are used for APA. Either format may be utilized for the APA 5"
and 6" editions. The following are simply examples of each. If aresource listing
breaks between two pages, start the resource on a new page.

Format 1 (using APA 5" Ed.): Hanging indent, single spaced, 1 blank line between
each resource.

(Arabic page number)

References
(1 blank line)

Kyle, R. M. J. (1965). School-to-work transition and its role in systemic reform of
education. Washington, DC: National Institute for Work and Learning, Academy
for Educational Development.

(1 blank line)

Luecking, R., & Fabian, E. (2000). Paid internships and employment success for youth in

transition. Career Development for Exceptional Individuals, 23(2), 205-210.
(1 blank line)

National Organization on Disability. (2002). What is the employability gap? Retrieved

December 2, 2004, from http://www.nod.org/content.cfm?id=968
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Format 2 (using APA 6™ Ed.): Hanging indent, double spaced throughout.

(Arabic page number)

References
Kyle, R. M. J. (1965). School-to-work transition and its role in systemic reform of
education. Washington, DC: National Institute for Work and Learning, Academy
for Educational Development.
Luecking, R., & Fabian, E. (2000). Paid internships and employment success for youth in
transition. Career Development for Exceptional Individuals, 23(2), 205-210.
National Organization on Disability. (2002). What is the employability gap? Retrieved

December 2, 2004, from http://www.nod.org/content.cfm?id=968
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Appendix C

MLA Style Examples

e Sample Table of Contents
e Sample Chapter Headings
e Sample Works Cited
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Sample Table of Contents (MLA)

The following example is consistent with a paper in the MLA format. Please refer to the
MLA Style Manual and Guide to Scholarly Publishing 3" Edition. Headings must
be presented in aformat identical to the format used in text.

Roman numeral page number must be %2 inch from top edge and flush with right
margin. Margins are 1.5” left, 1" top, right, and bottom. Center all text vertically
within the marqgins unless the TOC extends beyond one page.

(Last Name and small Roman numeral)

TABLE OF CONTENTS
(1 blank line)
Chapter Page
1. Yoo [U o3 Ao} o PSS PRSI 1
(1 blank line)
2. (=T = Y (0SSR SPPS 10
(1 blank line)
3. DS o1 £S1S] 0 SRS 22
(1 blank line)
4. (00} 0103 1157 0] o OSSPSR USRS 37
(1 blank line)
AT o O (=T RS 40
(1 blank line)
WOTKS CONSUIET.....c.eieiiieiie ettt esneenre e enes 41
(1 blank line)
N o] 01T o ) USRS PPRPP 43

Two-page TOC - If the Table of Contents is too long for one page, insert a break
between sections and continue on the next page. Beqin the continuation at the 1-inch

top margin.

Page Numbers — Align the page numbers flush right with dot leaders.

e In Microsoft® Word 2003, go to the Format menu and select Tabs. Select or type in
the tab stop position and select Alignment Right and Leader 2 ....... . Click Set and
Ok.

e In Microsoft® Word 2007, from the Home menu, go to the Paragraph section and
select the small arrowin the lower right corner. Select Tabs in the lower left corner
of the Paragraph window. Select or type in the tab stop position and select Alignment
Right and Leader 2 ....... . Click Set and OKk.

Please note that the page numbers are not italicized.

Very Long Heading — Be sure no heading extends into the page listing area. Continue a
long heading indented on the next line. List the page number opposite the last line of the
heading.
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Sample Chapter Headings (MLA)

Arabic page number must be ¥z inch from top edge and flush with right margin.
Margins are 1.5” left, 1” top, right, and bottom.

MLA Style: Please refer to the MLA Style Manual and Guide to Scholarly
Publishing 3" Edition.

Start each chapter on a new page.

(Last Name and Arabic page number)

Chapter |
(1 blank line)
Introduction
(1 blank line)
Indent five or use automatic indent (0.5”) and begin typing text. Text should be

double spaced throughout the research or thesis paper. Chapters should begin on a new

page. Works Cited is to be included in paper but not considered a chapter.

(Last Name and Arabic page number)

Chapter 11
(1 blank line)
Title of the Chapter
(1 blank line)
Indent five or use automatic indent (0.5”) and begin typing text. Text should be

double spaced throughout the research or thesis paper. Chapters should begin on a new

page. Works Cited is to be included in paper but not considered a chapter.
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Sample Works Cited

Arabic page number must be ¥z inch from top edge and flush with right margin.
Margins are 1.5” left, 1” top, right, and bottom.

Follow instructions in your thesis/research paper manual:

MLA Style Manual and Guide to Scholarly Publishing 3* Edition*** — see Chapter 6,
Documentation (pp.163-239)

e Works Cited — all works cited in your text, including not only books and articles

but also films, recordings, television programs, and other non-print sources
e Works Consulted — includes works not mentioned in your text but play an

important part in your research (this section should follow your “Works Cited”
section but start on a new page)

e Annotated Bibliography — contains additional information about the reference
source; formatting will require additional guidance from your committee

The following format is used for MLA. If a resource listing breaks between two pages,
start the resource on a new page.

Format: Hanging indent, double spaced throughout.

(Last Name and Arabic page number)
Works Cited
(1 blank line)

Kyle, Robert. School-to-Work Transition and Its Role in Systemic Reform of Education.
Washington, D.C.: National Institute for Work and Learning, Academy for
Educational Development, 1965.

Luecking, R., and E. Fabian. “Paid Internships and Employment Success for Youth in
Transition. Career Development for Exceptional Individuals 23.2 (2000): 205-
210.

National Organization on Disability. “What Is the Employability Gap?” 2 Dec. 2004

<http://www.nod.org/content.cfm?id=968>
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